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1.  
 
 

INTRODUCTION 

1.1. Research Background  

Video provides a powerful way to help you prove your point. When you click Online 

Video, you can paste in the embed code for the video you want to add. You can also 

type a keyword to search online for the video that best fits your document. 

 

Figure 1.1 Logo UniSZA (Ali et. Al, 2020) 

To make your document look professionally produced, Word provides header, footer, 

cover page, and text box designs that complement each other. For example, you can 

add a matching cover page, header, and sidebar. Click Insert and then choose the 

elements you want from the different galleries. 

Themes and styles also help keep your document 
coordinated. When you click Design and choose a new 
Theme, the pictures, charts, and SmartArt graphics 
change to match your new theme. When you apply 
styles, your headings change to match the new theme. 
(Jaafar, 2010) 
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Table 1.1 The number of hospital in Malaysia. 

Source: Malaysia Hospital report 2019 

1.2. MZJ Formatting Method 

 

Figure 1.2 A Sample of Formatting Method 

 

Figure 1.3 The Hadith on Knowledge  

Title Title Title 

To change the overall look of 
your document

To change the overall look of 
your document

To change the overall look of 
your document

To change the overall look of 
your document

To change the overall look of 
your document

To change the overall look of 
your document
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Figure 1.4 Hospital UniSZA (ASO, 2020) 
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1.3. Problem Statement 

Video provides a powerful way to help you prove your point. When you click Online 

Video, you can paste in the embed code for the video you want to add. You can also 

type a keyword to search online for the video that best fits your document. 

To make your document look professionally produced, Word provides header, footer, 

cover page, and text box designs that complement each other. For example, you can 

add a matching cover page, header, and sidebar. Click Insert and then choose the 

elements you want from the different galleries. 

i) Themes and styles also help keep your document coordinated. When you click 

Design and choose a new Theme, the pictures, charts, and SmartArt graphics 

change to match your new theme. When you apply styles, your headings 

change to match the new theme. 

ii) Themes and styles also help keep your document coordinated. When you click 

Design and choose a new Theme, the pictures, charts, and SmartArt graphics 

change to match your new theme. When you apply styles, your headings 

change to match the new theme. 

iii) Themes and styles also help keep your document coordinated. When you click 

Design and choose a new Theme, the pictures, charts, and SmartArt graphics 

change to match your new theme. When you apply styles, your headings 

change to match the new theme. 
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Video provides a powerful way to help you prove your point. When you click Online 

Video, you can paste in the embed code for the video you want to add. You can also 

type a keyword to search online for the video that best fits your document. 

To make your document look professionally produced, Word provides header, footer, 

cover page, and text box designs that complement each other. For example, you can 

add a matching cover page, header, and sidebar. Click Insert and then choose the 

elements you want from the different galleries. 

1.4. Research Objectives 

i) Video provides a powerful way to help you prove your point. 

ii) When you click Online Video, you can paste in the embed code for the video 

you want to add. 

iii) You can also type a keyword to search online for the video that best fits your 

document. 

iv) To make your document look professionally produced, Word provides header, 

footer, cover page, and text box designs that complement each other. 
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1.5. Research Limitation and Sample Size. 

a) Video provides a powerful way to help you prove your point. When you click 

Online Video, you can paste in the embed code for the video you want to add. 

You can also type a keyword to search online for the video that best fits your 

document. 

b) To make your document look professionally produced, Word provides header, 

footer, cover page, and text box designs that complement each other. For 

example, you can add a matching cover page, header, and sidebar. Click Insert 

and then choose the elements you want from the different galleries. 

Themes and styles also help keep your document coordinated. When you click Design 

and choose a new Theme, the pictures, charts, and SmartArt graphics change to match 

your new theme. When you apply styles, your headings change to match the new 

theme. 

1.6. Research Questions 

i) Video provides a powerful way to help you prove your point. 

ii) When you click Online Video, you can paste in the embed code for the video 

you want to add. 

iii) You can also type a keyword to search online for the video that best fits your 

document. 
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iv) To make your document look professionally produced, Word provides header, 

footer, cover page, and text box designs that complement each other. 

v) For example, you can add a matching cover page, header, and sidebar. 
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2.  
 
 

LITERATURE REVIEW 

2.1. Introduction 

Video provides a powerful way to help you prove your point. When you click Online 

Video, you can paste in the embed code for the video you want to add. You can also 

type a keyword to search online for the video that best fits your document.  1

Table 2.1 Summary from the literature from literature from literature from 
literature from 

Source : Jabatan Perangkaan Malaysia, 2020 

Table 2.2 The Title for This Table is Here 

Title Title Title Title Title

Title Title Title 

To change the overall look of 
your document

To change the overall look of 
your document

To change the overall look of 
your document

To change the overall look of 
your document

To change the overall look of 
your document

To change the overall look of 
your document

Source: World Bank report 2016

 Ahmad Kadri Junoh et al., “Smart Surveillance System Detection Using PCA- Based Feature Extraction” 1

Applied Mechanics and Materials. 232 (2012): 137–141.
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Table 2.3 The Statistical Information of APM Dataset 

Table 2.4 The Title for This Table is Here 

To make your document look professionally produced, Word provides header, footer, 

cover page, and text box designs that complement each other. For example, you can 

add a matching cover page, header, and sidebar. Click Insert and then choose the 

elements you want from the different galleries.  2

Themes and styles also help keep your document coordinated. When you click Design 

and choose a new Theme, the pictures, charts, and SmartArt graphics change to match 

Batch No of 
samples

Average per month Percentage of LoD 
(Coarse APM)

Percentage of LoD 
(Fine APM)

1 100 8 samples 1.70% 6.48%

2 102 9 samples 9.29% 9.09%

3 176 9 samples 2.65% 4.34%

Chemical C 
Composition

Surface Area (m2g-1) Porosity 
(cm3g-1)

Neutral clay 0.68 0.68 Neutral clay 0.68 0.68 Neutral clay 0.68 0.68

Bleaching clay Bleaching clay Bleaching clay

0.80 0.89 0.99

Note: Influence of the physical chemistry properties of an acid activated bentonite in the bleaching 
of olive oil. (Pradas et.al., 1993, p. 23)

 Faizir Ramlie et al., “A Significant Feature Selection in the Mahalanobis Taguchi System using Modified-Bees 2

Algorithm” International Journal of Engineering Research and Technology. 13.1 (2020): 117–136.
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your new theme. When you apply styles, your headings change to match the new 

theme  3

2.2. Sample Of Equation Is Here 

Themes and styles also help keep your document coordinated. When you click Design 

and choose a new Theme, the pictures, charts, and SmartArt graphics change to match 

your new theme. When you apply styles, your headings change to match the new 

theme as shown in (2.1). Equation (2.2) gives example on the use of word “Equation” 

in front of the equation numbering whenever a sentence starts with an equation. 

On the Insert tab, the galleries include items that are designed to coordinate with the 

overall look of your document. You can use these galleries to insert tables, headers, 

footers, lists, cover pages, and other document building blocks. When you create 

pictures, charts, or diagrams, they also coordinate with your current document look. 

You can easily change the formatting of selected text in the document text by 

choosing a look for the selected text from the Quick Styles gallery on the Home tab. 

You can also format text directly by using the other controls on the Home tab.  

(2.1)

(2.2)

3+= mxy

4+= mxy

 Wan Zuki Azman Wan Muhamad et al., “Combination of feature selection approaches with random binary 3

search and Mahalanobis Taguchi System in credit scoring” AIP Conference Proceedings. 1974.1 (2018): 20004.
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1. Literature 2 

To change the overall look of your document, choose new Theme elements on the 

Page Layout tab. To change the looks available in the Quick Style gallery, use the 

Change Current Quick Style Set command. Both the Themes gallery and the Quick 

Styles gallery provide reset commands so that you can always restore the look of your 

document to the original contained in your current template. 

 

Figure 2.1 The Spectrum of Cooking Oil 

2.3. Literature 3 

Video provides a powerful way to help you prove your point. When you click Online 

Video, you can paste in the embed code for the video you want to add. You can also 

type a keyword to search online for the video that best fits your document. 

To make your document look professionally produced, Word provides header, footer, 

cover page, and text box designs that complement each other. For example, you can 
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add a matching cover page, header, and sidebar. Click Insert and then choose the 

elements you want from the different galleries. 

1. Video Provides A Powerful Way To Help You Prove Your Point. 

Video provides a powerful way to help you prove your point. When you click Online 

Video, you can paste in the embed code for the video you want to add. You can also 

type a keyword to search online for the video that best fits your document. 

To make your document look professionally produced, Word provides header, footer, 

cover page, and text box designs that complement each other. For example, you can 

add a matching cover page, header, and sidebar. Click Insert and then choose the 

elements you want from the different galleries. 

2. When you click Online Video, you can paste in the embed code for the 

video you want to add. 

Video provides a powerful way to help you prove your point. When you click Online 

Video, you can paste in the embed code for the video you want to add. You can also 

type a keyword to search online for the video that best fits your document. 

To make your document look professionally produced, Word provides header, footer, 

cover page, and text box designs that complement each other. For example, you can 

add a matching cover page, header, and sidebar. Click Insert and then choose the 

elements you want from the different galleries. 
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3. You can also type a keyword to search online for the video that best fits 

your document. 

2.4. To make your document look professionally produced, Word provides 

header, footer, cover page, and text box designs that complement each 

other. 

Video provides a powerful way to help you prove your point. When you click Online 

Video, you can paste in the embed code for the video you want to add. You can also 

type a keyword to search online for the video that best fits your document. 

To make your document look professionally produced, Word provides header, footer, 

cover page, and text box designs that complement each other. For example, you can 

add a matching cover page, header, and sidebar. Click Insert and then choose the 

elements you want from the different galleries. 

1. For example, you can add a matching cover page, header, and sidebar. 

Video provides a powerful way to help you prove your point. When you click Online 

Video, you can paste in the embed code for the video you want to add. You can also 

type a keyword to search online for the video that best fits your document. 

To make your document look professionally produced, Word provides header, footer, 

cover page, and text box designs that complement each other. For example, you can 

add a matching cover page, header, and sidebar. Click Insert and then choose the 

elements you want from the different galleries. 
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2. Click Insert and then choose the elements you want from the different 

galleries. 

Video provides a powerful way to help you prove your point. When you click Online 

Video, you can paste in the embed code for the video you want to add. You can also 

type a keyword to search online for the video that best fits your document. 

To make your document look professionally produced, Word provides header, footer, 

cover page, and text box designs that complement each other. For example, you can 

add a matching cover page, header, and sidebar. Click Insert and then choose the 

elements you want from the different galleries. 

Themes and styles also help keep your document coordinated. When you click Design 

and choose a new Theme, the pictures, charts, and SmartArt graphics change to match 

your new theme. When you apply styles, your headings change to match the new 

theme. 

2.5. Save Time In Word With New Buttons That Show Up Where You Need 

Them.  

Reading is easier, too, in the new Reading view. You can collapse parts of the 

document and focus on the text you want. If you need to stop reading before you 

reach the end, Word remembers where you left off - even on another device. 

xv



Table 2.5 The Temperature Information 

Table 2.6 The Environmental Dataset Information 

Variable Minimum Maximum Average Standard 
deviation

Minimum temperature over 24 hours 
preceding 0300 GMT (0C)

0.0 30.0 15.33 7.06

Maximum temperature over 24 hours 
preceding 1200 GMT (0C)

12.5 44.7 29.85 6.93

Variable Minimum Maximum Average Standard 

deviation

Average relative humidity (%) 31.0 97.0 63.70 14.80

Average pressure (hPa) 994.37 1022.43 1009.04 6.48

Average wind speed (Knot) 0.0 9.0 0.79 1.43

Average rainfall (mm) 0.0 140.0 3.82 14.05
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Table 2.7 Summary of the Meteorological Parameters 

 

Figure 2.2 A Sample of Grass and Bamboo 2 

Variable Minimum Maximum Average Standard 
deviation

Minimum temperature over 24 
hours preceding 0300 GMT (0C)

0.0 30.0 15.33 7.06

Maximum temperature over 24 
hours preceding 1200 GMT (0C)

12.5 44.7 29.85 6.93

Average relative humidity (%) 31.0 97.0 63.70 14.80

Average pressure (hPa) 994.37 1022.43 1009.04 6.48

Average wind speed (Knot) 0.0 9.0 0.79 1.43

Average rainfall (mm) 0.0 140.0 3.82 14.05
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Table 2.8 The Sample of the Table with More Than One Page Items 
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N
o

M o l e c u l a r 
Descriptors

Abbreviatio
n

G r o u
ps

Amoun
t

Description

1 Cons t i t u t i ona l 
descriptors

Con 0D 48 0D-descriptors , independent from 
molecular connectivity and conformations. 
Atom and bonds counts, molecular weight, 
sum of atomic properties, etc

2 T o p o l o g i c a l 
descriptors

Topo 2D 119 Molecular descriptors obtained from the 
molecular graph (usually H-depleted), i.e 
2 D - d e s c r i p t o r s c o n f o r m a t i o n a l l y 
independent.

3 Walk and path 

counts

Wap 2D 47 Molecular descriptors obtained from the 
molecular graph, counting paths, walk and 
self returning walks of different lengths.

4 Connectivity 

indices

Coni 2D 33 Topological Molecular descriptors 
calculated from the vertex degree of the 
atoms in the H-depleted molecular graph.

5 Information 

indices

Info 2D 47 Molecular descriptors calculated as 
information content of molecules, based 
on the calculation of equivalences classes 
from the molecular graph. Among them, 
the indices of neighbourhood degree and 
edge multiplicity.

6 2D 

autocorrelations

2D 2D 96 Molecular descriptors calculated from the 
molecular graph by summing the products 
of atom weights of the terminal atoms of 
all the paths of the considered path length 
(the lag)

7 Edge adjacency 
indices

Edge 2D 107 Topological Molecular descriptors derived 
from the edge adjacency matrix which 
encodes the connectivity between graph 
edges.

8 Burden 

eigenvalues

Bur 2D 64 Molecular descriptors contained from the 
positive and negative eigenvalues of the 
adjacency matrix, weighting the diagonal 
element with atom weight.

9 Topological 

charge indices

Topoc 2D 21 First 10 eigenvalues (absolute values) 
obtained from a corrected adjacency 
matrix.

1
0

Eigenvalue-based 
indices

EiG 2D 44 Topological descriptors calculated by the 
eigenvalues of the square(usually 
symmetric) matrix representing a 
molecular graph.

1
1

Randic molecular 
profiles

Ran 3D 41 Molecular descriptors derived from the 
distance distribution moments of the 
geometry matrix, defined as the average 
row sum of its entries raised at the k-th 
power, normalized by the factor k.

xix



1
2

G e o m e t r i c a l 
descriptors

Geo 3D 74 Different kinds of conformationally 
dependent descriptors based on the 
molecular geometry. Reliable values are 
obtained if reliable conformations were 
previously calculated.

1
3

RDF descriptors RDF 3D 150 Molecular descriptors obtained by radial 
basis functions centred on different 
interatomic distances (from 0.5A to 
15.5A)

1
4

3 D - M o R S E 
descriptors

3D 3D 160 Molecular descriptors calculated by 
summing atom weights by different 
angular scattering function.

1
5

WHIM 

descriptors

WHIM 3D 99 Molecular descriptors obtained as 
statistical indices of the atom projected 
onto the 3 principal components obtained 
from weighted covariance matrices of the 
atomic coordinates.

1
6

G E T A W A Y 
descriptors

GATE 3D 197 Descriptors calculated from the leverage 
matrix obtained by the centred atoic 
coordinates (molecular influences 
matrix,MIM). The first four descriptors 
are calculated as information content and 
connectivity indices. HATA and H 
descriptors are 3D-autocorrelation 
descriptors obtained from MIM; R and R+ 
descriptors obtained from the leverage. 
Geometry matrix.

1
7

Functional group 
counts

Funct Others 152 Molecular descriptors based on the 
counting of chemical functional groups. 
They are calculated by knowing the 
molecular composi t ion and a tom 
connectivity.

1
8

A t o m - c e n t r e d 
fragments

Atom Others 120 Molecular descriptors, based on the 
counting of 120 atom-centred fragments, 
as defined by Ghose-Crippen. Some 
fragments are undefined by the authors. 
They are calculated by knowing the 
molecular composi t ion and a tom 
connectivity.

1
9

C h a r g e d 
descriptors

charged Others 14 Fourteen charge descriptors which are 
reliable only when charge are estimated by 
quantum molecular methods

N
o

M o l e c u l a r 
Descriptors

Abbreviatio
n

G r o u
ps

Amoun
t

Description

xx



2.6. Themes and styles also help keep your document coordinated. 

i) When you click Design and choose a new Theme, the pictures, charts, and 

SmartArt graphics change to match your new theme. 

ii) When you apply styles, your headings change to match the new theme. 

2.7. You Can Collapse Parts Of The Document And Focus On The Text You 

Want. 

a) If you need to stop reading before you reach the end, Word remembers where 

you left off - even on another device. 

b) Video provides a powerful way to help you prove your point. When you click 

Online Video, you can paste in the embed code for the video you want to add. 

You can also type a keyword to search online for the video that best fits your 

document. 

To make your document look professionally produced, Word provides header, footer, 

cover page, and text box designs that complement each other. For example, you can 

add a matching cover page, header, and sidebar. Click Insert and then choose the 

elements you want from the different galleries. 

Themes and styles also help keep your document coordinated. When you click Design 

and choose a new Theme, the pictures, charts, and SmartArt graphics change to match 

your new theme. When you apply styles, your headings change to match the new 

theme. 

xxi



Save time in Word with new buttons that show up where you need them. To change 

the way a picture fits in your document, click it and a button for layout options 

appears next to it. When you work on a table, click where you want to add a row or a 

column, and then click the plus sign. 

2. Word remembers where you left off - even on another device. 

a) Video provides a powerful way to help you prove your point. 

b) When you click Online Video, you can paste in the embed code for the video 

you want to add. 

c) You Can Also Type A Keyword To Search Online For The Video That Best 

Fits Your Document. 

d) To Make Your Document Look Professionally Produced, Word Provides 

Header, Footer, Cover Page, And Text Box Designs That Complement Each 

Other. 

e) For Example, You Can Add A Matching Cover Page, Header, And Sidebar. 

f) Click Insert And Then Choose The Elements You Want From The Different 

Galleries. 

Video provides a powerful way to help you prove your point. When you click Online 

Video, you can paste in the embed code for the video you want to add. You can also 

type a keyword to search online for the video that best fits your document. To make 

xxii



your document look professionally produced, Word provides header, footer, cover 

page, and text box designs that complement each other. 

For example, you can add a matching cover page, header, and sidebar. Click Insert 

and then choose the elements you want from the different galleries. Themes and styles 

also help keep your document coordinated. When you click Design and choose a new 

Theme, the pictures, charts, and SmartArt graphics change to match your new theme. 

When you apply styles, your headings change to match the new theme. Save time in 

Word with new buttons that show up where you need them. To change the way a 

picture fits in your document, click it and a button for layout options appears next to 

it. When you work on a table, click where you want to add a row or a column, and 

then click the plus sign. 

Reading is easier, too, in the new Reading view. You can collapse parts of the 

document and focus on the text you want. If you need to stop reading before you 

reach the end, Word remembers where you left off - even on another device. Video 

provides a powerful way to help you prove your point. 

When you click Online Video, you can paste in the embed code for the video you 

want to add. You can also type a keyword to search online for the video that best fits 

your document. To make your document look professionally produced, Word provides 

header, footer, cover page, and text box designs that complement each other. For 

example, you can add a matching cover page, header, and sidebar. 

xxiii



2.8. Literature 2 

When you apply styles, your headings change to match the new theme. Save time in 

Word with new buttons that show up where you need them. To change the way a 

picture fits in your document, click it and a button for layout options appears next to 

it. When you work on a table, click where you want to add a row or a column, and 

then click the plus sign. 

Reading is easier, too, in the new Reading view. You can collapse parts of the 

document and focus on the text you want. If you need to stop reading before you 

reach the end, Word remembers where you left off - even on another device. Video 

provides a powerful way to help you prove your point. 

1. Literature 3 

When you apply styles, your headings change to match the new theme. Save time in 

Word with new buttons that show up where you need them. To change the way a 

picture fits in your document, click it and a button for layout options appears next to 

it. When you work on a table, click where you want to add a row or a column, and 

then click the plus sign. 

Reading is easier, too, in the new Reading view. You can collapse parts of the 

document and focus on the text you want. If you need to stop reading before you 

reach the end, Word remembers where you left off - even on another device. Video 

provides a powerful way to help you prove your point. 
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2. Video provides a powerful way to help you prove your point. 

When you apply styles, your headings change to match the new theme. Save time in 

Word with new buttons that show up where you need them. To change the way a 

picture fits in your document, click it and a button for layout options appears next to 

it. When you work on a table, click where you want to add a row or a column, and 

then click the plus sign. 

Reading is easier, too, in the new Reading view. You can collapse parts of the 

document and focus on the text you want. If you need to stop reading before you 

reach the end, Word remembers where you left off - even on another device. Video 

provides a powerful way to help you prove your point. 

2.1. When you click Online Video, you can paste in the embed code for 

the video you want to add. 

2.2. You can also type a keyword to search online for the video that best 

fits your document. 

2.3. To make your document look professionally produced, Word 

provides header, footer, cover page, and text box designs that 

complement each other. 
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3.  
 
 

METHODOLOGY 

3.1. Introduction 

This chapter describes the methods, techniques and any validation of methods used in 

the study. This may include section(s) that describe the methodology in detail, the 

theoretical development, the hypothesis description, the fundamental philosophical 

foundation, the experimental design and the standard procedure description. For 

studies in the social sciences, a theoretical or conceptual framework should also be 

included. Published protocols or methods must be cited with references. 

3.2. Video Provides A Powerful Way To Help You Prove Your Point. 

1. When you click Online Video, you can paste in the embed code for the 

video you want to add. 

2. You can also type a keyword to search online for the video that best fits 

your document. 

2.1. To make your document look professionally produced, Word 

provides header, footer, cover page, and text box designs that 

complement each other. 

2.2. For example, you can add a matching cover page, header, and 

sidebar. 
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3. Click Insert and then choose the elements you want from the different 

galleries. 

Video provides a powerful way to help you prove your point. When you click Online 

Video, you can paste in the embed code for the video you want to add. You can also 

type a keyword to search online for the video that best fits your document. 

To make your document look professionally produced, Word provides header, footer, 

cover page, and text box designs that complement each other. For example, you can 

add a matching cover page, header, and sidebar. Click Insert and then choose the 

elements you want from the different galleries. 

Themes and styles also help keep your document coordinated. When you click Design 

and choose a new Theme, the pictures, charts, and SmartArt graphics change to match 

your new theme. When you apply styles, your headings change to match the new 

theme. 

To change the overall look of your document, choose new Theme elements on the 

Page Layout tab. To change the looks available in the Quick Style gallery, use the 

Change Current Quick Style Set command. Both the Themes gallery and the Quick 

Styles gallery provide reset commands so that you can always restore the look of your 

document to the original contained in your current template. 
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3.3. MZJ Formatting Method 

 

Figure 3.1 A Sample of Formatting Method 

 

Figure 3.2 The Hadith on Knowledge  
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Figure 3.3 Landscape of the Hospital  (SA, 2020) 

 

Figure 3.4 The screen for formatting a thesis using MS Word (MZJ, 2017) 
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